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SKI – ScreenKey Interface 

ScreenKey technology has been in use for a considerable number of years.   In 
this time, SKI has developed a range of software tools to simplify the task of 
integrating a ScreenKey console into an application or hardware solution. 

The principal operating system targeted by the SKI Software Toolset is the 
Windows platform.   

SKI publishes the device-level communications interface so that non-Windows 
users may employ ScreenKey consoles and devices in other environments. 

The SKI Software Toolset offers an advanced and feature rich set of software 
applications that enable developers and/or end-users to integrate a ScreenKey 
console quickly and easily yet providing the in-depth control capabilities to allow 
developers to maximise the potential of ScreenKey technology and the different 
console features. 

 

Note – Discontinued Products 

This document sometimes refers to products that have been discontinued by SKI 
(e.g. SK-2000 or SK-6000).  Please be aware that the software toolset continues 
to offer support for these products as an assistance to legacy users of these 
products. Product snapshots and examples used in this document sometimes refer 
to these products. 

 



Foreword 

ScreenKey consoles are available for Windows and IBM 46xx target platforms.  
These operating systems are very different and require different ScreenKey 
support software and utilities.  Please see ScreenKeys website 
(www.ScreenKeys.com) for further information. 

ScreenKey Active Control (SAC) files are used extensively by SKI in providing 
solutions for both target platforms.   

The Editor when installed is unique to a specific target platform.  Different 
installation programs are used to install the appropriate SAC Editor.  Please note 
that it is possible to install both versions of the Editor on to the same PC. 

The SAC Editor described in this document explains how to create and maintain 
SAC files for both systems although the Editor itself only runs on Windows 
platforms.  That is, SAC files for IBM 46xx systems must be created on a 
Windows PC and transferred to the 46xx runtime system.   

Other helpful documents are: 

ScreenKey Getting Started & Installation Guide 
Covers installation and how to get started for both Windows 
platforms. 

ScreenKey Planning and Installation Guide for IBM 46xx Systems 
Covers installation and how to get started for IBM 46xx systems. 

 

In this document pointing hands in the left margin are used to indicate differences 
for certain platforms and console types. Where Win-9x is mentioned, it applies to 
Windows 98 and Windows Me. 

 
Note 
 An upward pointing hand indicates that the whole chapter only applies to the 
description below the pointing hand. 

 A rightward pointing hand indicates a difference in that section if the hand 
is pointing to a section or a difference in the paragraph if the hand is 
pointing to a paragraph.  

 

Most of the information contained in this document is also available via the on-
line help. 

http://www.screenkeys.com/


  

Document: SAC Editor User's Guide - Issue 1.4 
Filename: SACEdUG.doc 
Page: 5 of 72 

Table of Contents 

SAC EDITOR OVERVIEW ................................................................................ 7 
What is ScreenKey Console?.......................................................................... 7 
What is SAC Editor?....................................................................................... 7 
Who should read this document?.................................................................... 8 

INSTALLATION PROCEDURE........................................................................ 9 
Hardware Installation .................................................................................... 9 
Software Installation ...................................................................................... 9 
Uninstallation of Software............................................................................ 10 

THE EDITOR ..................................................................................................... 11 
Editor Overview ........................................................................................... 11 
Designing SAC File Layouts......................................................................... 12 
Terminology.................................................................................................. 12 
SAC Editor Start-up...................................................................................... 13 
Options ......................................................................................................... 14 
SAC Editor shutdown ................................................................................... 20 
Opening an existing SAC file........................................................................ 20 
Creating a new SAC file ............................................................................... 20 
Editing more than one SAC file at a time ..................................................... 21 
Saving a SAC file .......................................................................................... 21 
Understanding the display............................................................................ 23 
What are ScreenKeys ?................................................................................. 25 
What are Fixed keys ? .................................................................................. 25 
What are menus ? ......................................................................................... 26 
Adding a menu.............................................................................................. 27 
Selecting the current menu ........................................................................... 27 
Deleting a menu............................................................................................ 27 
Copying a menu............................................................................................ 28 
Editing a ScreenKey or Fixed key ................................................................ 28 
Key Details ................................................................................................... 28 
Printing......................................................................................................... 31 
Unreferenced menus and graphics ............................................................... 31 
Menu Walk-Through..................................................................................... 32 

GRAPHICS.......................................................................................................... 33 
Editing/Creating a graphic........................................................................... 33 
If you make a mistake ................................................................................... 35 
“Loading Fonts” message............................................................................ 35 
Saving a graphic........................................................................................... 36 
Opening an existing graphic......................................................................... 36 



Document: SAC Editor User's Guide - Issue 1.4 
Filename: SACEdUG.doc 
Page: 6 of 72 

Loading an existing graphic ......................................................................... 36 
Copying a graphic ........................................................................................ 36 
Deleting a saved graphic .............................................................................. 37 
Closing an open graphic............................................................................... 37 
Renaming a saved graphic............................................................................ 37 
Exporting a saved graphic ............................................................................ 37 

SCANCODES ....................................................................................................... 38 
KEYBOARD OPERATION PARAMETERS............................................................... 40 
MODELOCK........................................................................................................ 42 

The Modelock editing window ...................................................................... 42 
Settings that affect all Modelock positions ................................................... 43 
Settings for individual Modelock positions................................................... 43 

MAGNETIC CARD READER (MCR) .................................................................... 46 
Settings that affect all MCR tracks ............................................................... 46 
Settings for individual MCR tracks............................................................... 47 

ERROR SETTINGS ............................................................................................... 49 
BACK MENU...................................................................................................... 51 

Purpose......................................................................................................... 51 
Creating and using a BACK menu................................................................ 51 

SELECT & CONFIRM MENUS....................................................................... 55 
What are Select & Confirm Menus? ............................................................. 55 
Creating Select & Confirm Menus................................................................ 55 
Defining Selection Keys and Colours ........................................................... 57 
Ending an S&C Menu ................................................................................... 59 
Defining the CONFIRM Key......................................................................... 61 
Special Notes ................................................................................................ 63 
Updating Editor to Support Select & Confirm Menus .................................. 64 

DOCUMENTATION CONTROL..................................................................... 67 
A.1 Change Control ................................................................................ 67 
A.2 Abbreviations Used/Terms of Reference .......................................... 67 
A.3 Historical Change Reference ........................................................... 67 
A.4 Change Summary ............................................................................. 68 

AUTOMATIC FILE CONVERSION ............................................................... 69 
Version 1.00 Data File.................................................................................. 69 
Version 2.00 Data File.................................................................................. 69 
Converting 1.00 to 2.00 ................................................................................ 69 

ERROR MESSAGES.......................................................................................... 71 
SAC EDITOR ERROR MESSAGES........................................................................ 71 



 7 
 

Do
File
Pag

I N T R O D U C T I O N  

SAC Editor Overview 

What is ScreenKey Console? 
The ScreenKey console is an Input/Output device for use with Point-of-Sale 
(POS) and other specialized applications, such as process control, dealer desks, 
call centers etc.  The ScreenKey console combines the best features of a standard 
console and a TouchScreen. It is made up of conventional fixed keys and special 
ScreenKeys. Each ScreenKey acts like a conventional key but incorporates a built-
in LCD display panel. This enables the ScreenKey’s legend to be changed at will. 
ScreenKeys are available in several configurations: 

• Resolution:   LC16 (32x16 pixels) or LC24 (36x24 pixels) 
• Backlight Colors: RG (red-green) or RGB (red-green-blue) LED backlighting 

Open Systems ScreenKey consoles connect to the PC via the Serial RS232 port.  
Future versions will be offered using USB interfaces. 

IBM 46xx ScreenKey consoles connect to the IBM POS terminal via socket 4 or 9 
of the device channel backplane (RS-485 connection). 
IBM 46xx  
Windows  
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What is SAC Editor? 
The SAC Editor is a software package that allows the design and maintenance of a 
ScreenKey menu-based navigation system in the form of a self-contained data file 
(SAC).  The data file contains all ScreenKey text, graphics, backlight colours, 
flash colours and keypress return codes as well as navigation rules to move 
between different ScreenKey menus.   

The SAC file can be used by other ScreenKey runtime components to control a 
ScreenKey console and to interact with a new or existing application. 

The SAC Editor may also be used as a generator and repository for ScreenKey 
graphics.  Graphics may be exported to binary and ‘C’ source files for use in other 
applications or other ScreenKey firmware designs. 
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Some of the benefits of ScreenKey consoles are: 

• Interface the ScreenKey console to an existing application with no 
changes to the application itself 

• Tailor the “Look and Feel” of the ScreenKey console to suit the 
application  

• Design user interface offline from the runtime system 
• Add security feature to the application using the Mode Lock with no 

application changes (available on some console types) 
 

 

Who should read this document? 
The User’s Guide is intended for the person who will create and maintain SAC 
files.  Typically this will be an operation or IT person but may be a software 
developer, system integrator, dealer or end-user. 

This guide assumes that the reader is familiar with Windows and Windows 
commands. 
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I N S T A L L A T I O N  

Installation Procedure 

 

Hardware Installation 
See the ScreenKey Console, Getting Started & Installation Guide document 
for details of hardware installation. 

See the Planning and Installation Guide document for details of hardware 
installation. 
IBM 46xx  
Windows  
cument: SAC Editor User's Guide - Issue 1.4 
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Software Installation 
The SAC Editor software is supplied on a CD or may be downloaded from the 
web (www.ScreenKeys.com). 

When distributed by CDROM, the CD usually incorporates an autorun facility that 
launches an installation helper utility (e.g. HTML file).  Follow the on-screen 
instructions as described by this utility to install the SAC Editor.  If the utility is 
not present or the autorun feature is disabled on your computer, you can install the 
software directly from the CD.   The ScreenKey software package typically 
includes several software applications that reside separately on the CD.  Find and 
open the SAC Editor sub-folder using Windows explorer from the root of the CD 
and run Setup.exe from this folder.  Follow the on-screen instructions presented 
during the installation process. 

If the software is downloaded from the Web, follow the instructions that come 
with the software. 

Follow the on-screen instructions during the installation process. 

http://www.screenkeys.com/
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Notes: 

1. Please refer to the installation README.PDF file that ships with the Editor 
distribution package.  This will contain the latest information on this product 
and specific installation instructions. 

2. If this is the first installation of ScreenKey software, the user will be prompted 
to specify the installation folder.  The offered default directory is C:\Program 
Files\ScreenKey, however any other directory can be selected by clicking on 
the Browse button. If the directory you choose does not exist, it will be 
created.  

3. If ScreenKeys software has been installed previously, the Editor will be 
installed into the folder previously assigned. 

4. The choice of target system installs determines the selection of keyboard 
templates that will be installed with the software as well as configuring 
enabling/disabling specific target platform options in the Editor. 

5. Dual installations may be created on one PC, i.e. one for Windows target 
platform and one for IBM 46xx target systems. 

 

Uninstallation of Software 
Installation of the SAC Editor creates a component in the “Add/Remove 
Programs” utility of the Windows Control Panel.  

IBM 46xx  
Windows  This is called SAC Editor when the target system is Windows platforms. 

This is called SAC Editor for IBM 46xx when the target system is IBM 46xx 
systems. 

 

To uninstall the software, launch the “Add/Remove Programs” utility from the 
Windows Control Panel. 

Select the component to de removed and click on the “Add/Remove” button at the 
bottom of the window. Click “Yes” to proceed with removal of the installed 
software.  
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T H E  E D I T O R  

The Editor 

Editor Overview 
The SAC Editor is a Windows application that allows SAC files to be created and 
maintained. 

The Editor operates offline from the runtime system and does not require the 
ScreenKey console to be connected to the PC while using the Editor. 

The SAC file is a binary file. Details of the data file format can be found in the 
document ScreenKey Console Technical Reference Manual (see 
www.ScreenKeys.com for latest version). 

The main features of the Editor are... 

• Supports all ScreenKey console (including legacy support for discontinued 
products, e.g. SK-2000) and ScreenKey types, including LC16 and LC24 
resolution and RG and RGB LED backlighting. 

• Allows menus (identified by menu names) to be set up for the ScreenKeys. 

• Allows Text/Graphics and key colour to be set up for each ScreenKey 
within each menu. 

• Supports Graphics editing, import from bmp or jpg files and export to 
binary or ‘C’ source files. 

• Allows one or more scan codes to be associated with a fixed key or 
ScreenKey. 

• Allows Barcodes to be associated with a fixed key or ScreenKey, either as 
manual input or by a bar code scanner. 

• Allows the display of a new ScreenKeys menu to be associated with a fixed 
key or ScreenKey. 

• Allows Magnetic Card Reader, Modelock and Error parameters to be 
defined. (dependent on console type) 

• Supports testing of the menu hierarchy without using the ScreenKey 
console. 

http://www.screenkeys.com/
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Designing SAC File Layouts 
One of the advantages of ScreenKey consoles is a reduced number of operator key 
choices at any one time.  This facilitates faster and more accurate input selections.  
ScreenKeys offer ‘multiple personalities’ dependant on the currently active 
ScreenKey menu (i.e. the same key performs different functions in different 
menus).  The actual menu offered to the operator is context sensitive with the 
current state of the application. 

As some functions are then only available via a menu ‘drill-down’ process, it is 
advisable to keep the more frequently used functions either on the Fixed keys or 
on the main (top-level) ScreenKeys menu. 

Terminology 
This software uses common Windows features familiar to all Windows users. 

In the documentation that follows, the following conventions are used: 

‘Press the Alt key and the M key then the C key’ which means that you must hold 
down the first key (Alt) briefly press and release the second key (M), release the 
first key, and briefly press and release the third key (C). The case (lower/upper) of 
the keys does not matter - ‘M’ in the above example is the same as ‘m’, so you 
don’t have to press the Shift key. 

A word in Italics means it is the subject of a section in the document. For example, 
‘... deletes the goto menu reference...’ means that there is a section in this 
document with the title Goto Menu. 

 

When designing SAC files for Windows platforms the term scancode is used to 
refer to key press return codes.  When ScreenKey Windows’s tools process SAC 
files, scancodes are translated to Windows keyboard messages. W

When designing SAC files for IBM 46xx platforms the term stemcode is used to 
refer to key press return codes.  These match original POS keyboards as per the 
selected keyboard template.  Please read stemcode wherever scancode is I
BM 46xx  
indows  
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mentioned in this document if the target platform is for IBM 46xx systems.  

 

The document often refers to Item Codes as a generic reference to scancodes or 
stemcodes. 
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SAC Editor Start-up 
Launch the SAC Editor from the shortcut placed on the Windows START menu. 

When first started, the following display is shown: 

 

From here, the user may create a new SAC file, open an existing file, configure 
the editor or exit the program. 

Keyboard Templates and Ini File 
Assigning scancodes to fixed or ScreenKeys is effectively the same as specifying 
one or more keystrokes that simulate pressing these keys on a qwerty keyboard.  
The relationship between scancodes and key positions on the qwerty keyboard is 
defined by a keyboard template file.  The SAC Editor is distributed with a 
standard 101-key UK keyboard template (kybgenuk.kbd).  The keyboard template 
actually uses and requires some additional template support files described below.  
Other template files may be obtained from SKI on request.  Users may modify this 
template to change the scancodes assigned to each key in the qwerty layout. 

Windows  

IBM 46xx  Assigning stemcodes to fixed or ScreenKeys is effectively the same as specifying 
one or more keystrokes that simulate pressing keys on a POS keyboard attached to 
the IBM 46xx terminal.  The relationship between stemcodes and key positions on 
the emulated POS keyboard is defined by a keyboard template file.  The SAC 
Editor is distributed with an IBM 50-key template (i46-050.kbd), IBM N50-Key 
template (i46-n50.kbd) and a 133 key POS template (i46-133.kbd).  Keyboard 
templates use and require additional template support files as described below.  
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Other template files may be obtained from SKI on request.  Additionally, users 
may modify the supplied templates to change or create new templates. 

An ini file (paskeyed.ini) resides in the install folder.  The currently selected 
keyboard template file (plus template support files) is recorded in this file.  This 
file also has entries that record the previous file history and an entry that specifies 
the target platform for this installation of the SAC Editor. 

The following file set is required to create a complete keyboard template.  Each 
member of the template file set has the same name but with a different extension 
(different file names may be used for the legend file). 

Filename Purpose 

*.kbd Defines scancodes/stemcodes for each key position 

*.lay Defines the key positions (relates to the bmp file) 

*.bmp Image (graphic) of the keyboard layout showing 
key positions  

*.leg Stores legends used on each key position 
 
Note: The 101-Key UK Keyboard template does not require a leg or bmp file. 

Options 
The Options menu looks like this in Windows target mode: 

W  
indows 
Document: SAC Editor User's Guide - Issue 1.4 
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and like this in IBM 46xx target mode: 

 

IBM 46xx  

The Options menu differs depending on the target system. In all cases there are 
menu items for turning the Toolbar and Tool Tips on or off, and a menu item for 
“Item Codes Setup”.  

Item Codes Setup 
This brings up a window for defining if and how item codes are entered.  

“Item Codes” are numeric only data that can be used to quickly enter key return 
codes (sequences).  Typically this represents barcode data, but they can be any 
number sequence.  “Item codes” differ from ordinary scancodes, which can be any 
combination of keystrokes, i.e. item codes are not restricted to numbers only.  All 
item codes are follwed by a suffix character  (e.g. 4711<enter>, where <enter> is 
the ASCII value for the Enter key).  The suffix character to use may be set in this 
window. 

If you wish to use item codes in the SAC file, tick the “Use Item code field” 
checkbox.  This enables an entry field called Item number in main SAC window. 

Actual item codes may be entered directly into the Item number field using either 
the qwerty keyboard or a barcode scanner attached to the PC.  Using a scanner can 
be useful in cases where all the item codes (barcodes) are listed in a book or 
similar.  

It is possible to use either a keyboard wedge scanner, or an RS-232 scanner: 

• Keyboard wedge barcode scanner 
This feeds the keystrokes through the keyboard cable as if they were typed on 
the keyboard. In this case it is not necessary to set up the Editor.  

• RS-232 barcode scanner 
This sends the scanned number through the PC’s RS-232 communication port 
and the Editor must be configured to support this method of operation. Tick 
the checkbox “RS-232 Bar code reader” to enable support for RS-232 
scanners.  Next specify the Com-port number to which the scanner is 
attached (1, 2, 3 or 4).  Note that if this type of scanner is used, barcodes will 
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only be entered in the Item number field, when this has the focus or a 
ScreenKey or fixed key has it. 

In both cases the scanner itself must be configured to read the required bar code 
types, to send numbers ONLY, and to send a Carriage Return (ASCII value 13) at 
the end. This Carriage Return is NOT the “Item Code suffix. 

Windows  The “Item code suffix” must be specified. This may be specified as either a 
hexadecimal scancode (as in the .kbd file) or as a decimal ASCII value. In the 
latter case, the program will look this value up in the scancode table, and send that 
scancode.  

IBM 46xx  For IBM 46xx target users, the actual suffix uploaded to the operating system is 
inferred from the barcode type (e.g. EAN13 uses a different suffix than UPC-A).  
The “Item code suffix” must still be specified in this window.  This value should 
be set to decimal ASCII value 13 (CR). 

The Item Code Setup window is only accessible when no file is loaded into the 
editor, and will apply for all opened files. 

WARNING 

THE INFORMATION DEFINED IN THIS WINDOW WILL BE SAVED TO A 
CONFIGURATION SETTINGS FILE (.INI FILE), AND NOT IN THE SAC FILES. IT IS 
THEREFORE CRUCIAL THAT THE EDITOR IS CONFIGURED THE SAME WAY WHEN AN 
OLD FILE IS UPDATED.  

Load Emulated Keyboard Template 
IBM 46xx  The Emulated keyboard template is a definition of the target emulation keyboard 

type. The template consists of three files, a “.kbd” file, a “.lay” file, and a “.bmp” 
file. All these have to be present in the editor install folder to have access to a 
template. The “.bmp” file is a bitmap file showing the keyboard as a picture, the 
“.lay” file describes to the editor where each key is placed and the “.kbd” file 
describes the stemcodes associated with each key. 

When you select this item a sub menu will be displayed showing all available 
templates, and which one is the current selected one. 

 

Select the desired template. After the template is selected, a legend file must be 
chosen that matches the newly selected template. If the current legend file does 
not match, a warning will be shown on the screen. You must then select another, 
or create one with the Emulated Keyboard Template Legend Editor. (see below). 
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Note: In Windows target platform this menu will not be shown.  The Emulated 
Keyboard Template will be set by default to “Kybgenuk”. 

Load Emulated Keyboard Template Legends 
IBM 46xx  The Emulated Keyboard Template Legends are the legend text on the keytops of 

the target emulation keyboard, e.g. the IBM 50 key keyboard. These legends 
match the setup of the IBM 46xx back office setup. The legends are defined in the 
“.leg” files, and they are loaded by selecting the template from the sub menu. All 
available legend files are shown as a submenu, and the current active legend file is 
ticked on the menu. 

 

Select the desired template legend file. When a template legend file is selected, 
this has to match the selected template. If the current legend file does not match, a 
warning will be showed on the screen. You then have to select another, or create 
one with the Emulated Keyboard Template Legend Editor. 

Note: Two legend files are shipped with the SAC Editor: default IBM 50Key for 
SA and default IBM 50Key for GSA 
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Edit Emulated Keyboard Template Legends 
IBM 46xx  The Emulated Keyboard Template Legend Editor is an editor that allows you to 

create a new or change an existing legends file. The editor works with the 
currently selected Emulated Keyboard Template. 

 

The Emulated Keyboard Template Legend Editor looks very much like the 
Scancode Editing Window, with some differences. To change a key’s legend do 
the following: 

• Select a key by clicking it with the mouse. 

• Type the key legend 

• Select the font size 

• Select if bold face or not 

• Repeat for each key 

There are certain rules that applies: 

• If using the Small font, all four lines may be specified and they appear with 
line 1 at the top, line 2 under line 1, and so on. The text will be left aligned. 

• If using the Medium font, only line 1 and 3 can be specified. Line one will 
appear in the top half of the key, and line 3 on the bottom half. The text will 
be left aligned. 

• If using the Numeric font (same font as number keypad), only line 1 can be 
specified, and it will be centred vertically, and horizontally.  
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The default file will be the file that is currently defined as the Emulated Keyboard 
Template Legend file. You may also load other files for editing. The local File 
menu item has the following commands: 

• Load Legend file 
• Save Legend file 
• Save Legend file as 

Load Legend file 
This menu item has a sub menu showing all available legend files. Select the 
desired file from the list and edit it. When a file is loaded or saved this file 
becomes the current Emulated Keyboard Template Legend file, and will be ticked 
accordingly under the Options menu in the main window. 

Save Legend file 
This menu item will save the changes to the legend file back to the file.  

NB: NO BACKUP FILE IS CREATED! 

Save Legend file as 
This menu item allows you to save the changed file to a different filename, which 
will be stored in the editor directory. This feature is useful when you want to 
create a new legend layout. 

 

If you exit the editor without saving, you will be warned about this but may 
choose to continue anyway.  Note however that the edited legend information 
remains in the editor’s memory and will be seen if you use the Edit scancode 
command.  Select another legend file to load this information into memory. 
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SAC Editor shutdown 
To exit the program click on the window close button, or click on the File menu 
and the Exit option.  If there are any open SAC files, you will be asked if you wish 
to save the changes.  If you are editing a graphic from an open SAC file you will 
not be allowed to close the file until you have finished editing the graphic (first 
save the graphic using the Graphic Save menu, then close the graphic using the 
Graphic - Close option). 

Opening an existing SAC file 
Open an existing SAC file* by clicking on the open document icon, or by 
clicking on the File menu and then clicking on the Open option.  This opens 

an explorer window from which you should select the file you require. If you 
select a valid file it will be opened after a short delay.  The program will issue a 
warning to the user if a SAC version 1 file is chosen.  The file will be 
automatically converted to version 2 (see page 69 for details) if the user continues. 

The five most recently used files are shown in the File menu, and can be opened 
by selecting their name. 
* SAC files have the extension .pkf 

Creating a new SAC file 
Create a new SAC file by clicking on the New document icon, or by 
clicking on the File menu and then clicking on the New option.  This opens 

a screen asking for the desired console type and the combination of ScreenKey 
and fixed keys required.  This information is stored in the SAC file. 

 

The Keyboard Layout definition Window 
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In the Keyboard Layout dialog box you first select the desired console type, then, 
if offered, select the panel combinations (panel combinations are not applicable 
for every console type). 

• SK-2000 Series [discontinued – legacy support only] 
This console type allows variations of the panel layout. Choose the 
combination of fixed key panel(s) and ScreenKey panel(s).  
The combinations may be from 0-3 panels of 12 ScreenKeys each, and 0-3 
fixed key panels of 20 keys each. 

• SK-3000/SK-7000 Series 
This console has one panel of 12 ScreenKeys at the left side and 37 fixed keys 
to the right. 
This console type does not allow variations of the panel layout. 

• SK-5400 Series 
This console has one panel of 12 ScreenKeys and no fixed keys. 
This console type does not allow variations of the panel layout. 

• SK-6000 Series [discontinued – legacy support only] 
This console has two panels of 12 ScreenKeys at the left side and 12 
fixed keys to the right. 
This console type does not allow variations of the panel layout. 

After setting the console configuration, the type of ScreenKeys must be 
specified for the target console.  Two selections must be chosen: 

• Resolution 
Select either LC16 (32x16 pixels) or LC24 (36x24 pixels) 

• Backlight Colors 
Select either RG (red-green) or RGB (red-green-blue) backlighting 

Editing more than one SAC file at a time 
There can be more than one SAC file open in an editing session.  It is not possible 
to copy key or menu details between the simultaneously open SAC files, although 
Graphics can be copied between the files.  

Saving a SAC file 
When a SAC file is open the Save icon is displayed. Click on this icon, or 
click the File menu then the Save option.  If the SAC file is unnamed (i.e. a 

new SAC file was opened and has not yet been saved) you will be asked for a 
name and a location to save it under, with an explorer style window. You can also 
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save the SAC file under a different name if you wish by choosing the ‘Save As...’ 
option on the File menu. 
NOTE If a SAC file with the same name already exists, this original file will be 
saved with an extension .pkb 
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Understanding the display 
After opening/creating a SAC file, a diagram of its console layout is shown on the 
screen. This diagram is the Key Details window. The fixed keys are shown smaller 
than the ScreenKeys, and have a grey key face. The ScreenKeys, which are larger, 
are initially shown with the imitated LCD screens in a white colour. 

Above the console display is a collection of boxes, initially blank, which are used 
to select or enter details about a particular key. 

All other windows are accessible from the Key Details window (you may have to 
select a key to be able to access other windows). 
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SK-3000/SK-7000 Series 

     
SK-2000 Series         SK-6000 Series 

 

 
SK-5400 Series 

Examples of the main Key Details Window for different console 
types 
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What are ScreenKeys ? 
ScreenKeys are pushbutton keys that incorporate a small LCD panel.  They are 
capable of displaying text or graphics (a graphic can also be used to represent text) 
on their face. They can also be illuminated in a variety of backlight colours, 
pressing a key can cause the menu to change, and one or more keystrokes can be 
sent to the application program. When you edit a ScreenKey the relevant editing 
fields are made available. These show the details of the current key being edited. 
Although there is room on the screen display for selecting graphics and for editing 
text, you can have one or the other but not both. 

Selecting a graphic to display on the ScreenKey erases any previous choice of 
text. If you want a graphic to be displayed on the ScreenKey you must use the 
graphics editing screen to create the graphic first. The same graphic can be shown 
on more than one key. When you select a graphic to be displayed (using the 
dropdown list), a representation of the graphic will appear on the key button. 

What are Fixed keys ? 
Fixed keys are similar to the conventional keys on computer keyboards. They 
cannot display variable graphics or text (they do not have an integrated LCD 
display).  Fixed keys can goto menu, insert scancodes, and be assigned a security 
level. 

Large Keytops 
It is possible to combine two or more fixed keys to work as one large key, like 
an Enter key or a Total key.  The upper left single key in a large key is the 
active part of the key, the others are inactive.  A large key will act as one 
ordinary fixed key.  

There are two ways to define a large keytop: 

• Using the mouse 

To define a large keytop using the mouse, simply place the mouse pointer 
outside one of the keys that would be a part of the keytop. Press and hold 
the left mouse button, move the mouse so the displayed rubber band 
surrounds the wanted keys, and release the mouse button. 
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• Using a dialog box 

Display the dialog box by clicking on the Make Large Keytop 
icon, or by clicking on the Option menu and then clicking on the 

Make Large Keytop option.  Select the width and height of the keytop by 
using the two dropdown menus, and click Ok. 
The dialog prevents you from defining an illegal keytop, because it 
adjusts the width and height choices dynamically to the maximum 
allowed. 

The large key will be displayed as a large button on the screen. 

A large keytop can NOT include another large keytop. If you wish to do that, 
undo the keytop first and then define a new one. It is therefore not possible to 
make an L-shaped keytop by combining two large keytops. 

Normally a large keytop is either one key high and two keys wide, one wide 
and two high, or two keys high and two wide. 

When a large keytop has been defined, the propeSKIes for the inactive keys of 
that large key will be lost, they are not restored if the key is redefined to single 
keys. 

Undo a large keytop by clicking on the Undo Large Keytop icon, or by 
clicking on the Option menu and then clicking on the Undo Large 

Keytop option.  The previous propeSKIes of the inactive parts of the large key 
will be lost. 

Definition of a Large Keytop must always start with the upper left button of 
the keytop, when using the dialog box 

What are menus ? 
Associated with ScreenKeys is the concept of menus. A menu allows different 
text, graphics, or key actions to be present on the same ScreenKey but at different 
times.  When you create a new menu you create a new set of information about the 
ScreenKeys. Each menu is given a name. If you have 2 menus, there will be 2 sets 
of information for each ScreenKey, one for the first menu, the other for the second 
menu. For example, in a supermarket application the top menu may be product 
type.  Pressing a key may access a menu of greengrocery items, and pressing 
another key may access a further menu of apples. 

It follows from this that you need to be able to access each menu, by pressing a 
key. This is done by the Goto Menu dropdown, which contains a list of menus. 
Selecting a menu from the list causes that menu to be active for the key when 
pressed. 
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Both ScreenKey and fixed keys can be assigned a goto menu. The fixed keys 
however are not part of a particular menu, because there would be no way of 
signalling to the operator the function of the fixed key if it changed. Fixed keys 
retain the same assigned function for all menus, ScreenKeys do not. 

Menus have names. Only the upper case letters (lower case is translated 
automatically to uppercase), the digits, and the dash and underscore characters are 
valid, and you can have a maximum of 10 characters. For example ‘MYMENU’ 
and ‘MENU_1’ are valid, but ‘MY MENU’ isn’t (because it has a space in it), or 
‘VERYLONGMENU’ (because its too long). For your ease of use, try to choose 
meaningful names, and plan your menu structure before you create any menus, 
defining the goto menu keys. 
NOTE Certain menu names are reserved and special menu naming conventions 
apply to define particular menu operations.  See pages 51 and 52 for examples of 
this. 

Adding a menu 
If the console contains any ScreenKeys there must be at least 1 menu. 
When you create a new SAC file, and click on a ScreenKey you will be 

asked for the first menu name. Although you can cancel this operation, it will be 
repeated until you enter a menu name. All the details you then enter for the 
ScreenKeys will be for that first menu. 
When you want to create another menu, click on the ‘create menu’ icon, or click 
on the Menus menu and the Add Menu option. When you have done this, the 
current menu will change to be the one you have just created. 

Selecting the current menu 
Click on the menu selector dropdown on the Key Details window, and choose the 
menu from the list of created menus. The name in the box is the name of the 
current menu. This name is repeated in the ScreenKeys surround (see the picture 
of the key details window). 

Deleting a menu 
If you delete a menu you delete all the information you have assigned to the 
ScreenKeys for that menu (references to graphics, but not the graphic itself, 

text, scancodes, etc.). Click on the delete menu icon, or click on the Menus menu 
and the Delete Menu option.  A list of menus will appear, from which you click on 
the name of the menu you wish to delete (if you do not want to delete any, click 
the Cancel button). Click the OK button to delete the menu you chose. You will be 
warned if the menu is referenced anywhere (i.e. if it is the subject of a Goto Menu, 
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or Initial Menu) and be offered the opportunity to cancel. If the menu you deleted 
was the current one, another menu will be made current (if there are any). 

Copying a menu 
You can copy a menu (which copies all the information assigned to the 
ScreenKeys - references to graphics, but not the graphic itself, text, 

scancodes, etc. from the current menu to a new one). Click on the copy menu icon, 
or click on the Menus menu and the Copy Menu option.  Enter a name for the 
copy (which must not exist), and click the OK button to copy the current menu. 

Editing a ScreenKey or Fixed key 
Click (or use the Tab and up/down arrow keys) to highlight a key.  The first time 
you select a ScreenKey (only when using the console), you must press the 
Spacebar to activate the selection (this is a requisite of Windows keyboard 
interactions and does not apply to mouse selections).  If you clicked on a 
ScreenKey, and there are no menus defined, you will be asked for a menu name 
(there must be at least 1 menu if there are ScreenKeys). 

Key Details 
As the user moves around the console, the details associated with the current key 
are displayed in the Key Details panel on the screen. Only the Goto Menu and 
Security fields are relevant when editing details for a fixed key. All fields are 
relevant when editing details for a ScreenKey. 

Go to Menu 
Select the name of the ScreenKey menu to be displayed when this key is pressed. 
If pressing this key should not update the ScreenKeys display then leave this field 
blank. The ScreenKey menu must already exist. 

Security 
Select a number in the range 0 to 4. A key assigned a Security Level value of 0 is 
always available. If the current security level of the console is less than the 
security level assigned to a key then that key is inactive. 

Graphic (ScreenKeys only) 
Select the name of the Graphic to be displayed when this ScreenKey is displayed. 
Graphics take precedence over text (i.e. if data is entered in both the Graphic field 
and the Text field then the graphic will be displayed and the text will be ignored) 
and the text is not saved. The Graphic must already exist. The graphics editing 
window is used to create graphics (see page 33). 
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Colour (ScreenKeys only) 
The ScreenKey is capable of displaying a range of colours. Select a colour from 
the dropdown. 
 

 
NOTE The number of colors shown depends on the target ScreenKey type, i.e. RG or 
RGB backlighting. 

Flash option and Flash Colour (ScreenKeys only) 
ScreenKeys may be configured to switch between colours. This feature is typically 
used to highlight a particular ScreenKey to the operator. The time that each colour 
is displayed for can be set independently in the Keyboard Parameters window 
(see page  40). If the flash option is not set (there isn’t a tick in the box) then the 
colour setting is ignored. 
NOTE These fields are used to other purposes in Select & confirm menus, see page 
52. 

Text (ScreenKeys only) 
To display text, (if a graphic is assigned, click on the graphic name in the graphics 
selection dropdown and press the PC keyboard Delete key), click on the ‘Text top’ 
input box, and type in the text for the top line of the key, up to 5 characters are 
allowed. In the ‘bottom’ input field, text for the lower line may be entered, again 
up to 5 characters. The full text will be shown on the key face in the editor in the 
current colour (up to 10 characters, 5 per line) when you either press the PC 
keyboard Enter key, or switch editing to another key/edit value (the text will not 
scroll in the editor). 

If text is defined for the ‘top’ line only, it is displayed in the centre of the 
ScreenKey display area. 
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Scancodes 
Scancodes are keystrokes that may be inserted into the application program 
when the ScreenKey or Fixed key is pressed. See page 38 for details. 

Keystrokes may also be entered as Item numbers, which is described below. 

For a key, the scancodes can be edited by clicking on the scancodes icon, or by 
selecting the Options menu ‘Edit Scancodes’ option. 

Item numbers and Barcodes 
The Item Number field can be disabled/removed from the Options/Item Codes 
Setup menu item. 

 

Item numbers are defined as a series of numbers followed by a suffix. Barcodes 
are defined as Item numbers. How Item numbers are handled is different for the 
two platforms supported, Windows and IBM-46xx. 

An Item number will always consist of numbers only. They may be entered after 
selecting the edit field called Item number in the lower right corner, or after 
selecting a ScreenKey or a fixed key. The Item numbers may be entered by 
pressing the number keys, or by using a barcode scanner. A barcode scanner may 
be a “keyboard wedge” type or an RS-232 type, see page 15 for more information.  

The barcodes and item number will not show any suffix in the Item number field. 
The suffix (typically the Enter code) is defined in the Options/Item Codes Setup 
window, page 15. 

Windows as target platform 
Windows  When designing SAC files for a Windows target platform, the item codes are 

treated as standard scancodes. These will be shown in the Scan Codes list, but 
since they are Item numbers the scancode edit template (Edit scancodes command) 
will not be accessible. To redefine an Item number, the user has to clear the Item 
number first.  Double clicking in the Item number field to select it and pressing the 
Del key may do this. 

IBM 46xx as target platform 
IBM 46xx  When designing SAC files for an IBM 46xx target platform, the item codes are 

treated as ASCII values, and marked as Barcodes. The supported barcode types 
are dependent on the particular ScreenKey console and IBM 46xx terminal 
configuration.  The barcode data is uploaded to the IBM terminal via the barcode 
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device channel if available (as if sent from a scanner itself) or may be converted to 
stemcodes and uploaded via the keyboard device channel if a barcode channel is 
not available.  The actions taken by the console depend on the console model and 
its configuration. 

The numbers will NOT be shown in the Scan Codes list, since they are not 
Stemcodes.  Stemcodes, which are defined with the scancode edit template, are 
always sent through the normal keyboard channel.  The scancode edit template 
(Edit scancodes command) will not be assessable when a barcode/Item number is 
assigned to a specific key. To redefine a barcode, the user has to clear the barcode 
first. Double clicking in the Item number field to select it and pressing the Del key 
may do this. 

Printing 
You can print out a copy of any open SAC file, including menus and 
graphics. You can only do this from the Key Details window. To print 

directly, click on the printing icon, or by clicking on the File menu and choosing 
the Print option.  This will print the SAC file to the default printer. Click the 
Cancel button (which appears whilst printing) to stop the printing. 

You can change the printer options including the default printer (before printing) 
by clicking on the File menu ‘Print Setup’ option.  Make the desired changes, then 
click the OK button to save them, or the Cancel button to abort changes.  

If you want to see what the printout will look like, click on the print 
preview icon, or by clicking on the File menu and choosing the ‘Print 

Preview’ option.  This shows the printout as it will appear when printed.  You can 
use this to check that you have entered everything before you print it. You can 
change the zoom scale to magnify the view, and use the scroll bars to move about 
the printout, and you can also resize the window (with AutoZoom). From this 
window you can setup the printer, and print the SAC file to the default printer. 
Click the Cancel button (which appears whilst printing) to stop the printing. 

Unreferenced menus and graphics 
All ScreenKey menus that have been set up should be referenced. They may be 
referenced by a key (see the Goto Menu field in the Key Details window, page 28) 
or by the Initial Menu (see the Initial Menu field in the Keyboard Parameters 
window, page 40). 

In the same way, all defined graphics should be referenced by a key (see the 
Graphic field in the Key Details window, page 28). 
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The editor expects all graphics and menus to be referenced and views any 
unreferenced items as being an error in the SAC file. The editor issues a warning 
when saving a file if graphics/menus are unreferenced. 

The maximum number of graphics that may be defined is 512. 

Menu Walk-Through 
You can use the menu walk-through feature to test the connection between the 
menus. Holding down the Ctrl-key, while you select a ScreenKey, will display the 
menu defined in the Goto Menu dropdown list. Select a ScreenKey by clicking on 
it or press the Spacebar.  

When you hold down the Ctrl key while in a ScreenKey panel (in Walk-Through 
mode), the Goto Menu text will be highlighted in red colour. When you then select 
the ScreenKey, the menu defined as a Goto Menu will be displayed. This way you 
may go through the whole menu hierarchy as if it was running on the ScreenKey 
console. 

The Menu Walk-Through works as if the menu specified by the Goto Menu field 
was selected from the Menu dropdown list.
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Graphics 

Editing/Creating a graphic 
The graphics editing window is a separate window within the SAC Editor and is 
used to create, modify, and edit graphics. A graphic is a pattern of dots (LCD 
pixels) which is shown on the face of a ScreenKey (you cannot show a graphic on 
a fixed key). Graphics are stored in the SAC file, and may be assigned to one or 
more ScreenKeys by using the graphics selection list available when editing the 
ScreenKey. 

To show the graphics-editing window (when you are editing a SAC file), 
click on the graphics icon, or click on the Options menu and the Graphics 

option. 

The graphics window shows a grid of cells representing the dots on the 
ScreenKey, and various controls below this. There are 4 ways to define a graphic 
using these controls, (which may be combined if desired). These are: 

• Setting individual squares of the grid 
• Using characters/symbols from the TrueType fonts installed with your copy 

of Windows. 
• Enter as text and have the Editor convert to a graphic. The conversion, 

TEXT2GRAPHIC, is based on a built in font that the user can modify. See 
ScreenKey Technical Reference Manual for details. 

• Import BMP or JPEG files created with another package. 
These are explained in turn. 

Setting individual squares of the grid 
The mouse pointer is used to set individual squares of the grid. Press the left 
button to set a square (turn it black), and the right button to clear it (turn it off). 

To fill a block of grid squares, simply hold down the left mouse button and drag 
the pointer until the desired block is outlined. On releasing the mouse button the 
block will be filled. The right mouse button can be used in the same way to clear a 
block.  
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The Graphics window 

NOTE If LC24 resolution ScreenKeys were selected as the target the Graphics 
window will show 36 pixels across and 24 pixels down. 

Using TrueType font characters 
Windows comes with a selection of TrueType fonts. These include plain and fancy 
characters, and various symbols (see the picture of the graphics window above). 
The first set of controls below the grid (in the ‘single character font setup’ box) is 
used to select a TrueType font, and to set its characteristics. 

To the right of the dividing line in the box is a test area. When you have selected a 
font (using the dropdown list), you can set the cursor to the keystroke box (click 
the mouse in the box, or use the tab key until the inseSKIon cursor appears in the 
box), and see approximately what the graphic will look like. (In the example 
shown, the font Wingdings is a symbol font. The letter J corresponds to the 
symbol for a happy face.) 

When you have selected the font details (font, height, bold, italic) you need to set 
the position where the desired character(s) will appear in the grid. The highlighted 
vertical bar on the grid shows where the character will appear. The height of this 
bar is the height of the character (set with the Height slider bar), and the position is 
the leftmost point of the character. You can set the base position of the vertical bar 
by holding the shift key down and clicking on a mouse button while the mouse 



 The Editor 35 
 

Document: SAC Editor User's Guide - Issue 1.4 
Filename: SACEdUG.doc 
Page: 35 of 72 

cursor is pointing at a grid cell.  If the base position is too close to the top of the 
grid the actual base position may be modified from the one you choose. 

You can now type the chosen characters into the grid, by pressing the desired 
keys.  Make sure the grid is the input area by using the tab key until a red border 
surrounds the grid. 

If you make a mistake, press the Ctrl and Z keys, or use the Edit menu Undo 
option to undo the change. 

Fitting text onto the graphic 
The third method uses an internal font and/or user defined font to compress text so 
that it fits onto the grid. You can have 1 or 2 lines of fitted text. (The font selectors 
in the box below the grid do not apply to this option). To use this option, first load 
any user defined fonts by clicking on the ‘Font File’ button, and using the explorer 
style file selector to choose the font file (see ScreenKey Technical Reference 
Manual for details of the format of these files). You must do this each time you 
open the graphics editor if you wish to use a user-defined font. Then type the 
desired text you wish to appear on the first line, and press the Enter key. The text 
will then be fitted (if possible) onto the grid, and shown vertically centred on the 
grid. If you require a second line of text, type it into the ‘Second line’ box. 

Import BMP or JPEG file 
The last method allows you to directly import a graphic created in another 
application.  You can import Windows BMP or JPEG files.  These files should 
match the ScreenKey resolution (32x16 or 36x24) and should be monochrome 
(black and white) images.  In the graphic drop-down menu, select ‘Import’ and 
browse to the desired file.  The import routine will automatically try to use the 
selected file in the ScreenKey resolution and will import the image as black and 
white regardless of its color settings. 

If you make a mistake 
When you make a change to the content of a graphic, it is possible to undo the last 
change. To do so, press the Ctrl and Z keys, or click the Edit menu Undo option. If 
you repeat these key/mouse strokes the change will be redone. 

“Loading Fonts” message 
It is not always necessary to load all fonts to the ‘Single character font setup’ list, if 
single characters are not used. If the PC has a lot of fonts installed, this will take some 
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time, each time the Graphic window is opened. Therefore these fonts are only loaded 
if they are needed. They will be loaded if the font list is selected, a character is typed 
in the ‘Graphics grid’, or a key is pressed while in the ‘Keystroke’ field. 

Saving a graphic 
Having produced a graphic it must be saved to a SAC file before it can be 
assigned to one or more ScreenKeys. You can save the graphic to any open SAC 
file. 

To save the graphic if it is unnamed, or if you wish to save it under a different 
name, choose the Graphic menu ‘Save As..’ option.  Enter a suitable name for the 
graphic (try to make it meaningful), and select a SAC file to save the graphic to. 
You cannot save a graphic to a SAC file that does not contain any ScreenKeys 
(there wouldn’t be any point). 

To save the graphic under the same name, use the Graphic menu Save option. 

The graphics-editing window title-bar shows the name of the graphic. 

If you are editing a named graphic, it is not possible to close the SAC file to which 
it belongs until the graphic is closed, or another graphic is opened, or the graphics 
editing window is closed. 

Opening an existing graphic 
You can open an existing graphic from any open SAC file by selecting the 
Graphic menu Open option.  Choose the SAC file, and the graphic from the 
dropdown lists. 

Loading an existing graphic 
You can load the contents of an existing graphic from any open SAC file by 
selecting the Graphic menu Load option.  Choose the SAC file, and the graphic 
from the dropdown lists. This option lets you take a copy of an existing graphic to 
change it without changing the original. 

Copying a graphic 
You can take a copy of a graphic at any stage by using the Graphic menu Copy 
option, or by pressing the Ctrl and C keys. You can then insert this copy (paste it) 
into another graphic by using the Graphic menu Paste option, or by pressing the 
Ctrl and V keys. 
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Deleting a saved graphic 
You can delete an open saved graphic by the Graphic menu Delete option. If you 
delete a graphic, all references to it in all menus of its SAC file are removed. You 
will be asked to confirm before deleting it. You cannot undo a delete operation. 

Closing an open graphic 
If you have been editing a graphic, and wish to create a new one, the close option 
can be used. This blanks the grid so you can start afresh. Select the Graphic menu 
Close option. 

Renaming a saved graphic 
You can rename a graphic by selecting the Graphic menu Rename option. Type in 
the new name. You cannot rename a graphic to the name of an existing saved 
graphic in the same SAC file, and you cannot rename across SAC files. 

Exporting a saved graphic 
The SAC Editor is a very useful tool for software and firmware developers 
working with ScreenKeys.  The SAC Editor can be used to generate ScreenKey 
graphics and as a ScreenKey graphic repository.  Saved graphics can be exported 
to individual files in a variety of different ways 

Binary Compiled: binary files with ScreenKey pixel data natively formatted for 
the ScreenKey LCD screen 

Binary Uncompiled: binary files with ScreenKey pixel data arranged in an easy to 
read structure, i.e. top-left to bottom-right of LCD screen 

‘C’ Source Compiled:  ascii file listing graphic data as a ‘C’ language source array 
with ScreenKey pixel data natively formatted for the ScreenKey LCD screen  

‘C’ Source UnCompiled:  ascii file listing graphic data as a ‘C’ language source 
array with ScreenKey pixel data arranged in an easy to read structure, i.e. top-left 
to bottom-right of LCD screen  
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Scancodes 
Scancodes are keystrokes that can be sent to the application when a fixed key or 
ScreenKey is pressed, and when certain other operations are performed (e.g. swipe 
a credit card in the magnetic card reader). What these keystrokes do is entirely 
dependent on the application being run. For example, a supermarket application 
may require a name of a fruit, and a ScreenKey displaying a picture of an apple 
may send the keystrokes ‘A’, ‘P’, ‘P’, ‘L’, ‘E’, ‘Enter’, or an Item number, say ‘4’, 
‘7’, ‘1’, ‘1’, Enter‘’ (Item number 4711). 

As you move around the console, the Scan Code details associated with the 
current key, if any, are displayed in the Scan Codes list. 

The scancodes display is a picture of a PC keyboard, or an IBM POS keyboard, 
called the “Emulated keyboard”, with a numbered ‘spreadsheet like’ grid display 
to its right which shows the defined scancodes, and their associated keystrokes. 
There are 3 ways to enter scancodes: 

1. By clicking on the picture of the appropriate key 

2. By pressing the corresponding key on the PC keyboard. This applies to the 
alphanumeric keys only, a-z and 0-9. Their corresponding scancodes will be 
entered automatically. The feature is available for faster entering of numbers 
and words. Note that the Enter key has a special function in Windows, and 
has to be entered by clicking on the Enter key on the template. 

3. By clicking on the ‘Edit’ button, and manually typing in the hexadecimal 
value of the scancode. The scancode that will be edited is that on the 
highlighted row of the grid. You are advised NOT to use this option unless 
you understand the nature of scancodes in detail! 

 

Some keys on the template are ‘shift-keys’ (Shift, Ctrl and Alt), and some are 
‘Lock-keys (Caps Lock). These all behave like expected, and the state is shown 
beneath the keyboard by highlighting the field describing the key with a green 
background.  

Windows  

IBM 46xx  Some of the IBM POS keyboards have a Ctrl-key. These also behave as expected, 
the same way as for the QWERTY keyboard, but in addition their templates have 
a Sticky-checkbox. If this is checked, the control key will NOT be released the 
next time a key is pressed, it will remain in down position until it is pressed again, 
or the checkbox is unchecked.  The user should verify that the required emulated 
IBM POS keyboard is supported by the ScreenKey console firmware. 
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You may assign up to 20 scancodes to a key. 

You must complete the editing of scancodes for a key, and exit the scancodes 
window (by clicking the OK button to save changes or the Cancel button to abort 
changes) before performing any other operation. 

See page 30 for how to enter Item numbers and Barcodes. 
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Keyboard Operation Parameters 
Clicking on the parameters icon, or clicking on the Options menu 
Parameters option will bring up the keyboard operation parameters window. 

Various ScreenKey console features are controlled from this screen. 

You must complete the editing on this screen before you can return to the Key 
Details window. When you have finished editing the values, click the OK button 
to save any changes, or Cancel to ignore changes. 

Initial Menu 
The ScreenKeys menu specified here is displayed on the ScreenKeys when the 
ScreenKey console is first connected. This field is mandatory if there are any 
ScreenKeys. You must have created the menu first (using Add Menu (page 27), or 
Copy Menu (page 28) choices on the main Key Details window if necessary). 

Enable keypress beep 
Setting this field (clicking on it, so a tick mark appears) enables the keypress beep 
feature, whereby when a key is pressed on the ScreenKey console an audible click 
is emitted. 

Enable Sleep Mode and Sleep Time Out Delay 
After a specified period of ScreenKey console inactivity (i.e. no user input) the 
ScreenKeys will go to sleep, and the ScreenKey colour changes to OFF. For 
example, if you want the ScreenKey console to go to sleep after 5 minutes of 
inactivity then set the Enable Sleep Mode parameter and the Sleep Time Out Delay 
parameter to 5400 (5 * 60 * 18). The limit is 9999 (or just over 9 minutes). 

Flash On Delay and Flash Off Delay 
There is an option to “flash” the ScreenKeys (see the Key Details). These 
parameters control the speed of this flash. The ScreenKey is shown with the 
normal colour for Flash On Delay time and with the Flash Colour (see the Key 
Details) for Flash Off Delay time. 

For example, setting Flash On Delay to 9 and Flash Off Delay to 18 will show the 
normal colour for half a second and the flash colour for one second. The limit is 
9999 (or just over 9 minutes). 
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Key Scroll Speed and Key Scroll Delay 
Legacy    
Consoles only 

 

There is an option to scroll text across the ScreenKey (see the Key Details 
window). The speed and delay parameters control the scroll. The text is displayed 
on the ScreenKey, and after the Key Scroll Delay time the text starts to scroll 
across the ScreenKey. The Key Scroll Speed controls the speed of scrolling. 

For example, setting Key Scroll Delay to 1080 (60 seconds x 18/sec) and Key 
Scroll Speed to 2 will start the scroll one minute after the text was first displayed 
on the ScreenKey and at a rate of one shift every ninth of a second. 

The limit is 9999 (or just over 9 minutes). 

 

 

The keyboard operations parameters window 
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The Mode Lock device (security key) on the ScreenKey console is used to 
implement a Security Levels feature (i.e. it can disable the console). The Mode 
Lock can also return keybstrokes to the controlling application and/or update the 
ScreenKeys menu. 

The Mode Lock key is available on the SK-2000, SK-3000 and SK-7000 series 
consoles only. 
odeloc

   
000 
000 
000 
onsoles only
The Current Security Level is set by the Mode Lock. 

When the current security level is less than that of the ScreenKey’s security level 
the ScreenKeys are dimmed (colour set to OFF) to indicate that they are inactive. 
Fixed keys may also be set inactive but there is no way to indicate this visually. 
When an inactive key is pressed it will beep as normal but no action will be taken 
(the ScreenKey and Fixed key security levels are set by clicking on the appropriate 
key and setting the security level). 

ScreenKey Console On/Off feature 
Consider setting the security level for all keys to at least 1 (this is set by default 
when you create a new SAC file). The effect is that when the Mode Lock is in the 
OFF position (the key is turned anticlockwise as far as it will go) all keys are 
inactive and in any other position all keys are active. 

Disable Security Level Feature 
There are two ways to disable the modelock security level feature: 

1. Make sure the ‘Modelock Security active’ box is not ticked in the 
modelock-editing window. 
 
With the SK-3510/SK-7510 consoles the Mode Lock is mandatory, it is 
not possible to turn the ‘Modelock Security active’ box off. 
IBM 46xx  
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2. For each key, set the Security field in the Key Details window to zero (see 
page 28). This effectively disables the modelock since all keys are active 
no matter what position the mode lock is in. 

The former is recommended, because it is easier to set, and can be turned on and 
off at will without affecting (and having to edit) the security level of each key). 

The Modelock editing window 
Clicking on the modelock icon, or clicking on the Options menu Modelock 
Settings option will bring up the modelock settings window. 
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You must complete the editing on this screen before you can return to the Key 
Details window. When you have finished editing the values, click the OK button 
to save any changes, or Cancel to abort changes. 

Settings that affect all Modelock positions 

Mode Lock Security active 
If this box is ticked, the security level feature is enabled. If it is not ticked, all 
modelock settings are ignored, and all keys function irrespective of their assigned 
security level. With the SK-3510/SK-7510 consoles the Mode Lock is mandatory. 

Prefix scancodes 
If any prefix scancodes are defined, they will be sent before any scancodes defined 
for the modelock setting when the modelock key is turned. If you wish to set the 
Prefix scancodes, click on the Edit button and set the scancodes in the scancode-
editing window (see page 38). 

Suffix scancodes 
If any suffix scancodes are defined, they will be sent after any scancodes defined 
for the modelock setting when the modelock key is turned. If you wish to set the 
Suffix scancodes, click on the Edit button and set the scancodes in the scancode-
editing window (see page 38).  

 

Settings for individual Modelock positions 
To set the individual position details, first decide on your security structure. For 
each security level that you intend to use, create a modelock setting. To do this, 
click on the appropriate security level in the key position list. These levels go from 
0 to 4 as the modelock key is turned clockwise. You will be asked if you wish to 
create the modelock setting if it does not already exist. If you subsequently decide 
you did not want a modelock setting for the current key position, click the Delete 
button. 

You can set (optionally) any of the following details: 

Scancodes 
If any scancodes are defined, they will be sent when the modelock key is turned to 
this position. If you wish to set the scancodes, click on the Edit button and set the 
scancodes in the scancode-editing window (see page 38). 
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Goto Menu 
Turning the key to a certain position can cause a different menu to be activated on 
the ScreenKeys. If you wish to set this, choose a menu from the dropdown list.  
You must have already created the menu using Add Menu (see page 27), or Copy 
Menu (see page 28) whilst in the main Key Details window. 
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IBM 46xx mode 
IBM 46xx  The IBM 46xx system has special modes associated with the Mode Lock key. 

These modes vary with the different consoles, and may be: 

• System   
• Inactive   
• Operator 
• Manager 

These modes may be assigned to each mode lock position, in addition to 
scancodes and goto menus. This selection list will only be visible when editing a 
SK-3000/SK-7000 console file (although they are only applicable to the IBM 
46xx versions of these consoles, i.e. the SK-3510 and SK-7510). 

 

The modelock editing window 
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Magnetic Card Reader (MCR) 
Clicking on the MCR icon, or clicking on the Options menu ‘MCR 
Settings’ option will bring up the MCR settings window. All details 

relevant to the operation of the MCR in the ScreenKey console are set here. 

W  

   
2000             
7000 
consoles only 

If your ScreenKey console does not possess an MCR you do not have to set any of 
these details. The SK-3510/SK-7510 consoles (IBM46xx platforms) may be 
equipped with a Magnetic Card Reader, but the SAC file does NOT handle the 
settings for these. 
indows 
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Magnetic cards (credit, debit, store, etc.) can have more than one track. You can 
choose whether one or more tracks are returned when the card is swiped through 
the MCR, and how, and in what format the data is returned. 

You must complete the editing on this screen before you can return to the Key 
Details window. When you have finished editing the values, click the Close 
button. 

Settings that affect all MCR tracks 
MCR active 
Setting this field (clicking on it, so a tick mark appears) enables the MCR. If it is 
not set, you cannot set any of the following options, and the MCR will not read 
card details. 

LUHN check 
Legacy    
Consoles only 
 

Setting this field (clicking on it, so a tick mark appears) enables the LUHN 
(account number check digit calculation) check feature. 

Return multiple tracks 
Setting this field (clicking on it, so a tick mark appears) enables the return multiple 
tracks feature. When more than one track is read successfully by the console and 
this option is set, all the tracks read are returned to the application program. If this 
option is not set, and more than one track is read, the track with the lowest 
preference is returned (e.g. if tracks with 2nd preference and third preference are 
read then the track with second preference is returned). 
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Return raw data 
Setting this field (clicking on it, so a tick mark appears) enables the return raw 
data check feature if set data read from the card is not translated. If not set, the 
data is translated into scancodes using the translation table specific to each track. 

 
MCR settings window 

Settings for individual MCR tracks 
To set the individual track details click on the appropriate track number in the 
track list. You will be asked if you wish to create the track details if it does not 
already exist. If you subsequently decide you did not want a track, click the Delete 
button. 

You can set (optionally) any of the following details: 

Track enabled 
Setting this field (clicking on it, so a tick mark appears) enables the track. If it is 
not set, you cannot set any of the following options, and the MCR will not send 
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any of the details (scancodes, etc.) for this track. A track that is not enabled will 
have its preference demoted automatically in favour of those tracks that are 
enabled. 

Track preference 
Track preference applies only when the Return multiple tracks option is not set, 
and the track with the best preference is sent. There are 3 potential preference 
settings, but you may not be able to set the preference (e.g. if there is only one 
enabled track its preference is automatically set to first, and you cannot set it). 
When available, click on the desired preference, and the preference of any other 
track will be readjusted. A track that is not enabled will have its preference 
demoted automatically in favour of those tracks that are enabled. 

Prefix Scancodes 
If any scancodes are defined, they will be sent before the track data is returned if 
the track has been successfully read and if it is of appropriate preference. If you 
wish to set the scancodes, click on the Edit button and set the scancodes in the 
scancode-editing window (see page 38). 

Suffix Scancodes 
If any scancodes are defined, they will be sent after the track data is returned if the 
track has been successfully read and if it is of appropriate preference. If you wish 
to set the scancodes, click on the Edit button and set the scancodes in the 
scancode-editing window (see page 38). 

Error Scancodes 
If any scancodes are defined, they will be sent if the track was not successfully 
read and this was the only track to be returned. Error scancodes are not sent if the 
Return Multiple Data option is set and at least one track was successfully read. If 
you wish to set the scancodes, click on the Edit button and set the scancodes in the 
scancode-editing window (see page 38). 

Translation table 
Each track has a translation table that converts the track data into scancodes before 
sending them to the application, when the track is read, and the Return raw data 
option is not set. If it is necessary to change this table, click on the ‘Translation 
Table’ button and set the scancodes in the scancode-editing window (see page 38). 
The table is of fixed length, and a scancode for each translation item is required. 
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Error settings 
The error settings are used to inform the end user, or the application, that an error 
has occurred in the operation of the ScreenKey console. An error may be caused 
by a communications malfunction, a problem in the console, a problem in the way 
the application talks to the console, or a problem in the SAC file. The error 
settings window is used to set the nature of this notification. 

 

   
2000 
5400 
6000             
7000 
consoles only 

Clicking on the error settings icon or clicking on the Options menu ‘Error 
Parameters’ option will bring up the Error settings window. All details 

relevant to error settings in the ScreenKey console are set here. 

You must complete the editing on this screen before you can return to the Key 
Windows 
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Details window. When you have finished editing the values click the Close button. 

 

Error Settings window 
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Error Beep active 
If this box is ticked, the console will emit a noise when an error occurs. 

Error Stuffing active 
Setting this field (clicking on it, so a tick mark appears) enables error stuffing. An 
explanatory error message (preceded by the prefix scancodes if any, and followed 
by the suffix scancodes if any) will be sent to the application when this option is 
set (the error message is sent as scancodes). 

Prefix scancodes 
If any prefix scancodes are defined, they will be sent before any error message if 
the Error Stuffing Active option is set. If you wish to set the Prefix scancodes, 
click on the Edit button and set the scancodes in the scancode-editing window (see 
page 38). 

Suffix scancodes 
If any suffix scancodes are defined, they will be sent after any error message if the 
Error Stuffing Active option is set. If you wish to set the Suffix scancodes, click on 
the Edit button and set the scancodes in the scancode-editing window (see page 
38).
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B A C K  M E N U  

BACK Menu 

   

 

Purpose 
When providing users with a series of product look-up tables, or in situations 
where the user may jump to a particular menu out of sequence with the current 
transaction, it can be very useful to provide a BACK capability.  That is, when the 
IBM 46xx 

   
Windows SAC 
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BACK key is pressed, the user is returned to the previous menu without having that 
menu explicitly declared in the SAC design. 

The BACK menu feature allows SAC designers to create self-contained menu 
subsets that can be executed from anywhere in the SAC processing loop.  

 

Creating and using a BACK menu 
To use this feature, the menu designer must create a menu called _B:.  It does not 
matter what this menu contains, as it will never be displayed.  It is only created 
because the Editor will not allow goto menus to undefined menus. 

Tip: 
Leave all ScreenKeys on the _B: menu but declare one as a Main Menu key 
pointing to the Main Menu.  This is useful to maintain navigation with the Editor 
whilst designing the menu. 
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When a SAC menu wishes to use the feature, simply declare a key with the goto 
menu pointing to the menu _B:. 
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For example: 

A user presses keys to trigger a sequence of menu displays A -> B -> C -> D -> E 
-> C: 

B C D E 

 

 
A 

 

 

If the operator presses the BACK key when on menu C at the end of the chain, this 
will return the ScreenKey display to menu E: 

 

B C D E 

BACK 
 

 

 A 
 

 

If the operator presses the BACK key when on menu C at the third step end of the 
chain, this will return the ScreenKey display to menu B: 

 

B C D E

BACK

 

A  

 

 

 

The use of the BACK feature is therefore ‘context sensitive’.  It returns the 
operator to the last displayed menu. 

 

The BACK feature maintains a list of the last TEN menus only. 
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S E L E C T  &  C O N F I R M  M E N U S  

Select & Confirm Menus 

   
IBM 46xx only 

What are Select & Confirm Menus? 
Select & Confirm menus are ‘special’ menus that operate differently to ‘normal’ 
SAC menus when displayed on the console. 

Keypress processing is handled slightly differently in these menus.  Particular 
keys are declared as Selection keys with alternate backlight colours.  The backlight 
colour of a Selection key is toggled when pressed to indicate if the item is selected 
or not.  Scan codes for the selected keys are only uploaded when a Confirm key is 
pressed. 

This feature might be used when an operator should be presented with a list of 
multiple choices, the final selection of which may always be different.  It would be 
wasteful to have to create a SAC menu for each possible combination of 
selections.  Select & confirm menus provide an element of dynamic selections into 
the SAC file design. 

Creating Select & Confirm Menus 
Select & Confirm menus are created in the SAC Editor in the same manner as 
standard SAC menus. 

Note: 
S&C menus are an implementation of ‘special’ menus requiring non-standard 
handling and are identified using a generic menu name framework. 

 

All S&C menus are identified by their menu name having the three-letter prefix 
_1:.  The remainder of the menu name can be assigned as normal. 

Note: 
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S&C menus are defined as type 1 using this naming convention.  There is scope to 
declare further non-standard or special purpose menus using _n: where n defines 
the menu type identifier.  No other menus are defined at this stage. SKI reserves 

the right to add new menu names in future product releases. 

 

The following example menu is created with the name _1:CHANGE 
 

 

There is no limit to the number of S&C menus supported.  The SK-7510 will 
automatically handle all menus beginning with _1: as S&C menus. 

 

Examples: 

  _1:CHANGE  S&C menu  

  CHANGE   Normal SAC menu 

  _1:MAINT   S&C menu  

  MAINT    Normal SAC menu 

 

 



 Select & Confirm Menus 57 
 

Document: SAC Editor User's Guide - Issue 1.4 
Filename: SACEdUG.doc 
Page: 57 of 72 

Defining Selection Keys and Colours 
Selection keys are displayed with an initial unselected colour.  This colour is 
toggled with an alternative colour when the key is selected.   

The selected and unselected colours are defined for each ScreenKey using the 
Editor’s Colour (Unselected) and Flash Colour (Selected) propeSKIes.  

The Flash On property must be UNCHECKED. When pressed, the key colour 
changes to the Flash Colour, indicating that the key is now Selected.   

 

For example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings for DOLLARS 
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Selection keys must not have a Goto Menu function defined. 

 

Non-selection keys may be defined and the Flash On property can be used to 
activate the ScreenKey flashing function.   

 

For example: 

 

CONFIRM 
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Ending an S&C Menu 
The chosen selections from an S&C menu are only uploaded to the terminal when 
the operator presses the Confirm key (see below for how to define the Confirm 
key).   

To abort the S&C menu without uploading the chosen selections, a Goto Menu 
key must be provided.  This can be either a fixed key or a ScreenKey. 

The menu that is displayed next from the Goto Menu key is not relevant.  Jumping 
to any menu during an S&C menu automatically cancels and aborts the selection 
process. 

 

The following example shows how an abort key is provided as part of the S&C 
menu: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ABORT Key uses Goto 
Menu
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These keys are termed Action keys (i.e. with goto menu propeSKIes assigned).  
They are handled exactly as ordinary SAC menu keys; i.e. if defined with flash 
colour then they will flash as expected, otherwise they will display the colour 
defined in the SAC menu.  Pressing an action key ends the S&C menu handling.  
The action key colour will not be changed.  If the key has stem-codes assigned 
then these will be uploaded to the terminal. 

 

Tip: 

As fixed keys are ACTIVE during S&C menus, operators may press the numeric 
keys before aboSKIng the S&C menu.  It is useful to add the CLEAR stem-code to 
the ABORT key. 
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Defining the CONFIRM Key 
The Confirm key is defined using a new special purpose key in the Editor.  It is 
created as normal, i.e. key text or graphic, colour, flashing, etc, but is assigned a 
special stem-code: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CONFIRM key has special stem-code 
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The Confirm stem-code is assigned in the normal manner from the Editor screen: 

 

Confirm Key  
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Special Notes 
The following topics must be considered when using Select & Confirm menus. 

 

1. Fixed Keys 

The fixed key panel remains active during S&C menu processing.  This can 
cause difficulties for the operator if they press a fixed key that uploads stem 
codes that are somehow incompatible with the S&C menu.  For example, the 
operator could total and cash out a transaction whilst still in the S&C menu if 
these keys are available on the fixed key panel.  Mostly this will not be a 
problem.   

The reason for leaving the fixed keys active is that the CLEAR key must be 
available in case the operator/SAC file generates an error requiring the 
operator to press CLEAR.  Typically, CLEAR is a fixed key. 

 

2. Modelock Operations 

The Modelock can be operated as normal during S&C menu processing.  S&C 
menus may be created with different security levels assigned to the menu 
ScreenKeys.  When the Modelock is in a lesser security position then relevant 
ScreenKeys are made disabled and their colour is turned off.  If the Modelock 
position is changed when an S&C menu is displayed, the S&C menu is reset 
and selections already made are discarded. 

If a modelock position is set to generate a goto menu, this action causes the 
S&C menu to be aborted. 

If a modelock position includes stem codes then these are immediately 
uploaded to the terminal as per the fixed key operations. 

 

3. Goto Menu API Commands 

When a Goto Menu API command is received whilst an S&C menu is 
displayed, the API menu name is entered into the list of previous menus as the 
last menu. 

If the user then aborts the S&C menu using the BACK menu feature (_B:), 
then the API supplied menu is displayed.  If an explicit menu is used to abort 
(or Confirm) the S&C menu then that menu is displayed and the API menu 
remains in the menu history list. 
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Updating Editor to Support Select & Confirm Menus 
Previous releases of the Editor for IBM 46xx platforms (version 2.54 and earlier) 
do not provide a Confirm key selection in the stem-code assignment window. 

Newer versions of the Editor install the following replacement files to the Editor 
install directory with Confirm key defined: 

• I46-O50.BMP Graphic with Confirm key placement on 50-Key keyboard 

• I46-O50.LAY Matching layout file for 50-Key keyboard 

• I46-O50.KBD Stem-code assignment for each 50-Key position 

 

However, it may be necessary to update the legend files (*.LEG).  This process 
can be done manually. 

Notepad or another text editor can be used to update the legend files.  Open each 
legend file and find the following line: 

43, "", "", "", "", S 

Insert the line below after line 43 shown above: 

44, "CONFIRM", "", "", "", S 

The remaining lines in the file now have incorrect offsets that must be 
adjusted.  Run through the remainder of the file incrementing each line offset 
(the first number in the line) by one.  The last line should have an offset of 56. 



 Select & Confirm Menus 65 
 

Document: SAC Editor User's Guide - Issue 1.4 
Filename: SACEdUG.doc 
Page: 65 of 72 

For example: 

A legend file without Confirm key defined would look like: 

42, "", "", "", "", S 
43, "", "", "", "", S 
44, "EXEC", "TIME4", "", "", S 
45, "CLEAR", "", "", "", MB 
46, "MODIFY", "TICKET", "", "", S 
47, "TOTAL", "", "", "", MB 
48, "0", "", "", "", N 
49, "/", "", "", "", N 
50, "ENTER", "", "", "", MB 
51, "QTY", "", "", "", MB 
52, "", "", "", "", S 
53, "", "", "", "", S 
54, "DIAG", "", "", "", M 
55, "EXEC", "TIME5", "", "", S 

 

After amending this file with Notepad, to add the Confirm key it should look 
like: 

42, "", "", "", "", S 
43, "", "", "", "", S 
44, "CONFIRM", "", "", "", S 
45, "EXEC", "TIME4", "", "", S 
46, "CLEAR", "", "", "", MB 
47, "MODIFY", "TICKET", "", "", S 
48, "TOTAL", "", "", "", MB 
49, "0", "", "", "", N 
50, "/", "", "", "", N 
51, "ENTER", "", "", "", MB 
52, "QTY", "", "", "", MB 
53, "", "", "", "", S 
54, "", "", "", "", S 
55, "DIAG", "", "", "", M 
56, "EXEC", "TIME5", "", "", S 
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A P P E N D I X  A  

Documentation Control 

A.1 Change Control 
This document is the responsibility of the author and is subject to formal change 
control after the initial approved release (i.e. issue 1.0). 

A.2 Abbreviations Used/Terms of Reference 
MCR Magnetic Card Reader 

Menu A Menu is a collection of ScreenKey records that are treated 
as a single unit. 

Non-Scanned 
Items 

Non-scanned items are items that are sold in a retail outlet 
which do not have a bar code assigned to them 

PC Personal Computer. 

POS Point of Sale--the cash register in a shop. 

SAC ScreenKey Active Control 

Scan Code A scan code consists of 2 bytes--usually 1 byte for the ASCII 
value and 1 byte for the keyboard position code. 

Stemcode The IBM 46xx term for a keystroke code. 

IBM 46xx IBM Point Of Sale terminal system running either General 
Sales Application (GSA) or supermarket Application (SA). 

  

A.3 Historical Change Reference 
Issue Date Author Changes Made 

1.0 12/03/99 B. Liane Initial Release 
1.1 08/02/01 M. McDonnell Add S&C Menu support 

Major revamp of content 
1.2 15/03/04 M. McDonnell Rewrite for SK-7000 features 
1.3 15/12/05 M. McDonnell Update for LC24 and RGB 

support 
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1.4 30/11/06 M. McDonnell Update for graphic 
import/export 

    

A.4 Change Summary 
1.0 This Document used to be part of PWDUM001.DOC (Windows 

95) and PWDUM003.DOC (Windows NT), which also included 
the emulator and technical references.  

1.1 Add new section that describes Select & Confirm menu setup for 
use with IBM 46xx systems. 
Add new section for BACK menu feature 
Completely revamp text, rewrite sections on IBM 46xx target 
platform 

1.2 Rewrite for SK Interfaces, include features of SK-7000 

1.3 Update information to include details on added support for LC24 
and RGB backlighting from 3.0 onwards 

1.4 Add info on BMP/JPG import and export of graphics to binary 
and ‘C’ source files 
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A P P E N D I X  B  

Automatic File Conversion 
 

When the Editor loads a Version 1.00 data file, it automatically converts the file 
format to Version 2.00. The file is subsequently saved as a Version 2.00 file. The 
user is informed when Automatic File Conversion is being performed. 

Version 1.00 Data File 
This is the file format used by the original DOS version of this system. The SAC 
Editor never created version 1.00 Data files. 

Version 2.00 Data File 
This is the file format used by the original Windows version of this system and 
later DOS versions. Windows can automatically convert from version 1.00 to 
version 2.00. 

Converting 1.00 to 2.00 
1. Security Levels: Mode Lock security is set to inactive by default when 
conveSKIng from a version 1.00 data file--the Mode Lock Security settings in the 
version 1.00 file are ignored. 

2. There is no ASCII2SCANCODE record in version 1 files so the default table is 
used—see the ASCII2SCANCODE record layout for details. 

3. There is no MCR information in version 1.00 files. 

4. Colour Codes: The SAC Editor limits the allowed colours to those in the 
following table… 

None 0 
Dark Red 1 
Bright Red 5 
Dark Green 2 
Bright Green 10 
Dark Orange 3 
Bright Orange 7 
Greenish Orange 14 
Reddish Orange 9 
  

The DOS ScreenKey File Editor (the DOS equivalent of the SAC Editor) allows all 
Colours in the range 0 to 15. So, the converted file may contain colour codes that 
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cannot be entered using the SAC Editor. No warning is given when Colour Codes 
outside those allowed by the SAC Editor are read in from a version 1.00 file or a 
version 2.00 file written by the DOS ScreenKey File Editor.
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A P P E N D I X  C  

Error Messages 

SAC Editor Error Messages 
The Editor will communicate with the user via the use of pop up message boxes. These 
message boxes may be for information only, warnings about the validity of the current 
operation and for error repoSKIng. The following is a list of the more commonly 
encountered errors. There may be other error conditions that arise as a result of the 
program fault conditions. As a general rule these errors are usually accompanied by an 
error number which you should report to customer support. 

 
File: <Filename> does not exist  

The SAC file does not exist. Check spelling and/or path. 

Error : opening file 

Unable to open SAC file for binary access.  

Error : reading file <reason> 

The editor has encountered a problem whilst reading the SAC file. The reason field gives 
the precise area of the problem. 

Error : writing file <reason> 

The editor has encountered a problem whilst saving the SAC file. The reason field gives 
the precise area of the problem  

Error : not a ScreenKey file (SAC) 

The editor has determined that the file supplied is not a valid ScreenKey console SAC 
file. 

Error : wrong version 

The SAC file supplied has a version number that is incompatible with this release of the 
SAC Editor.
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Error : corrupt file <reason> 

The SAC file supplied is corrupt. The reason field specifies the precise area of the 
problem. 

Error : memory allocation <reason> 

The Editor is unable to store all data specified in SAC file. The reason field specifies the 
precise area of the problem 

Error : invalid number format, should be either NUMBERFORMAT  =  HEX  or 
 NUMBERFORMAT = DECIMAL 

Invalid number format encountered while reading font definition in the Graphic editor. 

Error : invalid offset format, should be OFFSET = <number> invalid  font 
 definition, should be 20 comma separated numbers 

Invalid offset format encountered while reading font definition in the Graphic editor. 
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